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Introduction

As research on Alzheimer’s disease and related dementias (ADRD) centers on detecting
symptoms earlier in the insidious onset process, there is an increasingly pressing need to
develop methods for detecting them, presumably before the impact of the underlying
pathological changes are irreversible. While there have been great advances in developing
imaging and blood-based biomarkers of AD at the clinically pre-symptomatic level, the
presumption of “pre-symptomatic” is currently being driven by the tools used to detect them.
Measuring longitudinal changes in cognitive function is one of the core clinical indicators of
pathological onset.

Surprisingly the research efforts to build more sensitive tools of cognitive function have not kept
pace with that of PET/MRI imaging or fluid (blood/CSF) biomarkers. Yet cognitive function
remains the primary outcome against which all these biomarkers as well as clinical trial
treatment impact are measured. Thus, the AD research community is investing in methods for
detecting AD pathology emergence at its earliest point but has not made concomitant
investment in methods for detecting AD-related cognitive symptoms that might be emerging in
parallel.

The implementation of digitally recording participant responses to neuropsychologist tests is the
easiest, most cost-effective way to detect early changes in cognition. Speaking is a cognitively
complex task and thus embedded in the spoken responses are acoustic and linguistic features
that likely map onto the multiple cognitive domains implicated by neuropathological changes. As
our cognitive capabilities shift, we express them through vocal responses in subtle ways, such
as switching up word choices or sentence structures because of word finding problems,
pausing, hesitating, and shifting as memory, attention, and executive functions are
compromised.

Currently, there are no gold standards in methods for analyzing voice recordings, but just as
with blood-based biomarkers, there is a growing, albeit still limited, literature suggesting that
analysis of digital voice recordings as a method for differentiating those with and without
cognitive impairment is promising. Thus, to facilitate the opportunities of using digital voice as a
novel method for assessing cognition, we provide a manual of operations that describes how to
collect digital voice recordings for research purposes.

Rhoda Au, PhD
Investigator at Framingham Heart Study Brain Aging Program

Professor of Epidemiology at Boston University



About this Manual

This document is adapted from the manual published by the ADRC Clinical Task Force
Cognitive Working Group, in collaboration between the Framingham Heart Study Brain Aging
Program at Boston University and the Indiana Alzheimer’s Disease Research Center. It serves
as a guide for researchers interested in audio recording of cognitive testing for research
analysis.

To implement audio recording in research protocols, please see the following four sections:

e [nformed consent

It is crucial to provide an in-depth description of the audio recording implementation and use of
the data as part of the informed consent process. In addition, it is important to provide detailed
information regarding data usage, storage, and protection. A copy of the FHS-BAP consent form
can be found under Appendix B: FHS-BAP Consent Form.

e Selecting Audio Recording Equipment

For audio recording equipment, consider the following factors: portability, data storage space,
battery life, ease of set up, sampling rate, etc. FHS-BAP uses the Zoom H4N recorder. Refer to
here for alternative models.

e Storage and retrieval of audio recordings

Use a standardized naming convention for the audio recording files and maintain a data log for
inventory management.

e Post data collection processing

Generating analysis-ready files is resource intensive. It may not be possible for all researchers,
especially if funding may be an issue. Personally identifiable information is a common concern
for audio recordings; hence these files must undergo post data-collection processing before
they can be made available for analysis, especially in situations where the sensitive data are
being shared with other researchers.



Part 1: Basic Digital Voice Capture

Language for IRB and Informed Consent

The Framingham Heart Study Brain Aging Program (FHS-BAP) records the consent process in
addition to the battery, however researchers can choose to only record the testing battery. The
excerpts below can help researchers develop their own language to include in IRB and consent

forms.

FHS-BAP includes the following statement in its IRB application.

“Prior to beginning the consent process, participants will be asked for their
permission for the investigators to audio record the consent process. These audio
recordings of the consent process will be used for quality control purposes only.
The investigators will also ask permission to audio record the study examinations
as well. Audio recordings of study exams will be used for research analysis.
Participants will also be asked if a portion of the motor exam can be recorded for
research purposes. The consent process will not be video recorded. If participant
does not agree to audio and video recording, the recordings will not be done.
Participants have the right to refuse being recorded at any time during the exam.”

The FHS-BAP IRB application also contains the following language specifically regarding

visits.

“Use of this method of interview is expected to have minimal risks. The risk involves
potential for breach of confidentiality. The risk is minimized by using a secure web
platform that is used by many hospitals and clinics for doctors to communicate with
patients, hence we believe it will be secure for this research interview. The visits
will be digitally recorded (1x participant/month will be video recorded via Zoom
recording and each participant will be audio recorded) and kept on FHS servers
similar to our audio recordings of in person cognitive testing. The video recordings
will be retained for short term storage, long enough for QC purposes, and will then
be destroyed/removed. The FHS forms are filled and stored at the main FHS
facilities along with all other FHS records. Participants can always decline to
answer any question or decline to complete any test even if the participant
consents and completes to the rest of the questions or test within the
examinations.”

virtual

The FHS-BAP Informed Consent Form contains the following questions and statements about
audio recordings.



Audio and Video Recording: The neuropsychological and neurological examinations will be audio
recorded. The motor assessment of the neurological examination and remote neuropsychological
exam will be video recorded. The audio and video recordings will be analyzed in conjunction with
other study information.

Do you agree to have the neuropsychological and neurological examinations audio recorded?

YES NO N/A INITIALS

Do you agree to have the neuropsychological and neurological examinations video recorded?

YES NO N/A INITIALS

Within the description of what will happen in the study:

“This session will be recorded using a digital audio recorder. Recordings will be
analyzed in conjunction with other study information. We will also use recordings
to make sure that your responses are accurately documented.”

For virtual visits:
“Remote Neuropsychological Examination (Remote Cognitive Testing): You will be offered

the option to continue participating remotely if you are unable to participate in-person. If
this occurs the following additional procedures will take place.

Before Your Virtual Visit: The virtual visit/remote testing will take place using your
electronic device. You will need to have steady access to the internet and will use your
own device (computer/laptop/iPad/tablet). There will be technical support for any
guestions prior to or during the encounter. The remote testing will be done using a BU
approved platform for interviews such as Microsoft Teams and/or BU HIPAA Zoom.

During Your Virtual Visit: You will be asked similar questions and administered the same
tests that you would encounter during an in-person neuropsychological exam. The tests
given virtually will mimic in-person tests as much as possible with modifications only
made to facilitate virtual use. You may be offered a second in-person evaluation at your
convenience, in your home or at

our office, in the future.

Within the Confidentiality section:
“We will store your information in ways we think are secure. We will store paper files in a
locked secure location. We will store electronic files in computer systems with password
protection and encryption. Access to these records is limited to authorized FHS staff.
However, we cannot guarantee complete confidentiality. The files will be kept indefi-
nitely, and there are no plans to destroy any of the records. Coded data and digital/video
recordings from all tests will be stored in a repository and will be shared with internal and



external investigators. This means that your data will be shared in a way where other in-
vestigators can gain access to them without review. although your previously indicated
preference of sharing data for commercial and/or non-commercial purposes will be hon-
ored. Data may be shared with qualifying collaborators with or without FHS investigator
involvement. There are multiple studies taking place at FHS that use the same exams
(neuropsychological exam, neurological exam, and MRI). To reduce burden on you so
that you do not have to repeat the same exam for multiple studies, we will share the re-
sults of study exams with these other FHS studies. Your identity will be shared when
study data is shared with other FHS studies...”

Refer to Appendix B: FHS-BAP Consent Form for an IRB approved example.




Selecting Audio Recording Equipment

The audio equipment selected by a researcher will greatly affect the quality of recordings. In this
section we have outlined the important details to consider in this selection process.

FHS-BAP uses the Zoom H4N recorder, which meets the criteria below — see Appendix C for
detailed instructions on its use. Additional recording device recommendations can be found in

Appendix D.

Factors to consider when choosing a recorder:

1.

2.

Portability (if off-site testing is done)
Compatibility with lab’s computers (Mac/PC/Linux)
Both AC Adapter and Battery options for power (rechargeable battery preferred)

Microphone: We recommend choosing a recording device that can lay on the table in
front of the participant and that has two microphones (for better sound quality than a
single mic) as part of the recorder.

Lapel mics, which clip to the participant’s shirt, may pick up too much rustling noise if the
participant moves. Headsets might be too cumbersome or uncomfortable. Hanging
(ceiling mounted) mics are not portable. If using external mics, avoid using condenser
microphones (they pick up more room reverb); use cardioid mics instead.

Recording capacity: Depending on lab conditions, determine whether the recorder can
collect multiple sessions before downloading the files to a computer, or whether it needs
to be downloaded after each testing session.

Sampling rate: The sampling rate is one measure of audio quality, expressed in Hertz
(Hz). The lowest acceptable sampling rate is 16000 Hz and we recommend capturing
audio at a sampling rate of 44100 Hz.

Format/encoding: We highly recommend collecting voice data in the WAV format with
LINEAR16 PCM encoding with at least 16000 Hz sampling rate. (For more detailed
information on audio recording format and encoding, see references 2-3.)

Quantity: If multiple testing sessions are scheduled simultaneously, testers will need
more than one recording device. If testers go off-site for sessions (i.e. to the participant’s
residence), they will need to take the device with them. Researchers should consider
acquiring an extra device in case one is broken or lost.

Additional equipment: if the chosen recorder requires an SD card, researchers should
ensure that multiple SD cards are purchased in case some are lost.



Audio Setup and Calibration

Recorder placement and the sound quality of the testing room will greatly impact the recording

guality. Sound reverberating off bare walls & floors, humming equipment, external noises (e.qg.,
loud colleagues, birds chirping, etc.), and microphone direction are some of the factors that can
diminish sound quality of voice recordings.

Sometimes these features are not under the tester’s control, and we must work with what we
have. This is especially true when recording is done in the participant’s home. However, if you
have the option to make changes to the testing environment, consider the following:

Ideal Testing Room

1. Small to medium size

2. Multiple soft surfaces like carpet, couches, pillows, etc.

3. Avoid rooms that have a lot of hard surfaces that will make sound bounce around, such
as windows, bare walls, and hard floors

4. Minimal exposure to external sounds (e.qg., street noise, a conference room, loud
colleagues, ringing phones, plumbing, weather)

5. Turn off noisy things in the room (e.g., fan, phone, air conditioner, computer in overdrive)

6. Lay a towel or piece of cloth under the recorder

Placement of recorder
1. Point the mic(s) of the recorder toward the participant (and away from tester)
2. Place it in a location where it will be out of the way of testing (once you start recording,
you don’t want to be moving the recorder around)
3. If possible, place the recorder on furniture that is NOT the desk/table you are working on
(because sounds such as pages turning, bangs on the table, etc. get picked up), but be
sure it is close to the participant

The recording quality can be improved by sound-treating the testing room(s):
1. Floors
a. Carpet/rug
2. Ceiling/walls
a. Bass Traps
b. Acoustic Panels
c. Alternatively, can use packing blankets or mattress foam
d. Or, do it yourself (DIY)
i How to build a sound absorbing panel in 5 easy steps
ii. How to build your own acoustic panels
ili. Budget Audio Treatment
iv. Cheap Sound Treatment Tests in a Commercial Office
V. How to install acoustic foam without damaging your walls

Vi. Tips for DIY

The quality of audio can also be affected if the participant and/or examiner are wearing masks.
It is recommended to track whether masks were worn for each testing session and if the
participant, examiner, or both were wearing a mask.

A test recording in every testing room should be performed beforehand to confirm the quality of
sound recording for data extraction.


https://ehomerecordingstudio.com/bass-traps/
https://www.amazon.com/dp/B07C94ZZ57/ref=sspa_dk_detail_0?psc=1&pd_rd_i=B07C94ZZ57&pd_rd_w=lVNGc&pf_rd_p=57cbdc41-b731-4e3d-aca7-49078b13a07b&pd_rd_wg=9xUtc&pf_rd_r=6H4QB698GYRB0C846NN6&pd_rd_r=7469b9b0-e635-406c-a5c8-192324234aad&s=musical-instruments&smid=A2G7YTOQK3LF58&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUE4TjgyWTYxOTEwNzEmZW5jcnlwdGVkSWQ9QTAxMTQwMDUySVJHUFpXM0hDTTM2JmVuY3J5cHRlZEFkSWQ9QTAwMDczNjAzMEs4QkpYMDdNSlRKJndpZGdldE5hbWU9c3BfZGV0YWlsX3RoZW1hdGljJmFjdGlvbj1jbGlja1JlZGlyZWN0JmRvTm90TG9nQ2xpY2s9dHJ1ZQ==
https://www.amazon.com/s?k=packing+blankets&i=tools&crid=2CD8L8DLQFLFM&sprefix=packing+blankets%2Ctools%2C142&ref=nb_sb_noss
https://www.fullenglish.co/blog/2016/8/13/sound-absorber
https://www.youtube.com/watch?v=NvWUEXtT2js
https://www.youtube.com/watch?v=7h84lrQQTl8
https://www.youtube.com/watch?v=QUanE8y0Xis
https://www.youtube.com/watch?v=LIPXq0WAnpg
https://www.acousticsinsider.com/best-insulation-material-diy-acoustic-absorbers/

Make sure that every tester is trained in how to use the recording equipment and what to do
with the audio recording after the testing session.



Recording

We recommend that researchers record the entire cognitive battery in a single recording,
because it might be distracting to the participant if the tester is repeatedly starting and stopping
the recorder. However, researchers have the flexibility to record individual tests if they prefer to
do so. In a later section, we provide instructions on how to split a single recording into multiple
audio files so that each test is in a separate audio file.

Some tests are virtually silent, such as Trails, but we encourage researchers to continue
recording even during these silences. Audio recordings can be used to analyze many different
angles of testing, so it can be useful to record during quiet tests to catch if people speak or
make noise during the test (such as verbalizing during Trails).

Saving Unedited Audio Files & Data Log

After testing, the examiner will download the recording from the recorder to a computer and
save it. All files should be saved with a standardized naming convention.

It is imperative that researchers maintain a data log with the following data variables for each
recording:

Study patrticipant ID

Accession #

Visit date

Visit number

Cognitive tests (

Interviewer initials

Whether the participant and/or interviewer were wearing masks
o l=interviewer
o 2=participant
o 3=both interviewer and participant
o 4=no mask

e Where the recording took place

o 1=clinic
o 2=home
o 3=nursing home or assisted living
o 4=other

o Name of the recording device used

If Part 2: Generating Analysis-Ready Files is part of the research protocol, these additional
variables should be tracked in the data log:

PHI removed (Y/N)
Date of processing
Initials of processer
Program used
Quiality check

10



Part 2:

Generating Analysis-Ready Files

Personally Identifiable Information

Personally Identifiable Information (Pll) is information that can be used to identify, locate, or
contact a single individual. It is essential that all Pllis removed from the recording prior to
sharing with outside investigators. Examiners should try to avoid using a participant’s name

during testing;
testing that wo

however it is not uncommon for a participant to say something in the middle of
uld be considered PII and therefore must be removed.

Types of Pll to Flag

This is a comp

rehensive list of the types of PIl. Some types may occur more frequently during

testing than others.

1. 18 HIPAA identifiers® of the individual or of relatives, employers, or household members

of the individual:

a.
b.

C.

LT O3 TXARTToTQ OO

r.
2. Resear
1.

Name (including maiden name)
All geographic subdivisions smaller than a state, including street address, city,
county, precinct or neighborhood area, ZIP code, and their equivalent geocodes.
All elements of dates (except year) for dates directly related to an individual:

i.  Birth date

ii.  Admission date

iii.  Discharge date

iv.  Date of death

v. All ages over 89 (as well as the year of birth for this age group)
Telephone numbers
Fax numbers
Email addresses
Social Security numbers
Medical Record numbers
Health plan beneficiary numbers
Account numbers
Certificate/license numbers
Vehicle identifiers (e.g., serial numbers, license plate numbers)

. Device identifiers and serial numbers

Web URLs

Internet protocol (IP) address

Biometric identifiers, including finger and voice prints

Full face photographic images and any comparable images

Any other unique identifying number, characteristic, or code
ch-related Identifiers

Start-of-Exam Recorded Identifiers: Participant ID, tester ID, and date

3. Regional Identifiers

1.
2.
3.

Schools attended
Place of work
City of birth

11



Procedure for Testers to Flag PlI

PIl may not occur often during the recorded testing, and testers can limit Pl by collecting all
participant-related information before beginning the recording and being mindful of speaking PII
such as referring to the participant by name.

It is extremely important that the examiner pay attention to every time PII is spoken by either
themselves or the participant. Upon speaking/hearing any such information, the examiner
should mark the active battery page at the time of the PII. If the examiner is not using paper for
the test (for example, the use of a computer or tablet instead), a standardized way to mark when
Pll is spoken should be decided upon. All examiners should use the same way of marking PII, in
case the examiner who conducted the tests is not the same person who removes PIl from the
recording.

12



Processing Audio Recording

Use an audio editing software to remove PII from each recording. Researchers might have
testers process the audio that they recorded, or they might have someone else process the
recordings using the tester’s notes where they flagged PII.

Researchers can choose their preferred software as long as it can silence PIl in such a way that
it cannot be reversed and can save audio files in the WAV format. After silencing PII in the
recording, the edited audio file should be saved with a standardized file naming convention and
corresponding details should be entered in the data log for sharing with external investigators.
(Do not save over the unedited audio file, save as a new file).

We recommend using the software Audacity, which is a free audio recording and editing
software for Windows, Mac, and Linux. Researchers can download Audacity here:
https://www.audacityteam.org/download/

Audacity can be used to record audio with a connected microphone, or researchers can use a
separate device to record and then download the recording to a computer that has the Audacity
program. To open an audio file in Audacity, you can drag-and-drop the file or open Audacity, go
to File > Open, and navigate to the appropriate file.

There are many online tutorials and instructional videos for Audacity users, so looking up your
guestions online will usually yield a solution. For an introduction to the program, watch the
first 4 minutes of this video: https://www.audacityteam.org/download/ (after 4 minutes, the
video describes editing and noise reduction that you will not do for this project). We recommend
that new users become familiar with the Audacity program and practice the following steps with
sample audio before working on research recordings.

Labeling and Silencing PII in Audacity

Audacity has a Silence tool that you will use to remove Personally Identifiable Information (PII)
from the recording. To learn how to use the tool, watch this video
(https://youtu.be/Vgl6PUNVOfY) and then follow the steps below.

You will follow these steps in conjunction with the steps in the next section (“Using Labels to
Save Cognitive Tests as Individual Files”), so it is important to read and practice all the steps
before working on recordings.

e After opening the appropriate audio recording in Audacity, go to the drop-down menu at
the top of the program and find Tracks. Select Add New > Label Track. You will use
the label track to mark when PII occurred in each recording.

e Listen to the audio to find the first occurrence of Pl in the recording. If you click and drag
on the audio track, you can highlight a portion of audio; if you press play, it will only play
the highlighted section of audio. (This also works if you highlight part of the label track.)

e You can use the Zoom tools to zoom in on the audio: a9

¢ Once you find PII, click and drag on the label track until you have highlighted the area
with PII (you can press play to check). You can click and drag the start and end points of
the highlighted section and keep replaying the segment until you have isolated the PII.

13


https://www.audacityteam.org/download/
https://www.audacityteam.org/download/
https://www.audacityteam.org/download/
https://www.audacityteam.org/download/
https://youtu.be/VgI6PUNv0fY

Tip: It might be hard to avoid including words on either side of the PII: for example, if
someone says "Yep, my brother's name is John Smith and oh, um..." - It might be hard to
not also grab when they say "is" and "and" on either side of "John Smith", depending on how
fast they speak. We want to limit non-Pll speech in the segments, but don’t spend too much
time trying to avoid capturing a word or two on either side of the segment. Overall, the idea
is "do your best effort" on limiting non-PlIl speech.

e Press ctrl + B or cmd + B. This will create a label at the location you have highlighted.
Type “PlI”.

¢ When you click on the “PlI” label you made, it will highlight the selected audio. Click on
the Silence icon or use ctrl+L to silence the selected audio:

O

i > m 14 > ® W
KOO (1) n~ aa/aalQ
MME v \./ Microphone Array (Realtek(R) Au
v 5.0 6.0 7.0

o Repeat these steps with each segment of Pll until all are labeled and silenced.

Using Labels to Save Cognitive Tests as Individual Files

Researchers should record all cognitive tests in a session as a single audio file. This is optimal
because starting and stopping the recording for each test could be distracting to the participant.
You can use Audacity to easily split and save each test as an individual audio file. Here is a
video explaining this feature (https://youtu.be/72ewbraagj8).

e At the top of the Audacity program, find the drop-down menu for Tracks. Select Add
New > Label Track. (Researchers can also use a label track to save timestamps of PII.
This step will create a second label track. It is important to use separate label tracks
for the two tasks.)

¢ Find the beginning of the first cognitive test. Click on the second label track so the
vertical line is positioned before the first test begins.

e Press ctrl + B or cmd + B. This will create a label at the location you have selected. (If it
creates a label on the PII label track instead of the cognitive test label track, it's because
you need to click on the second label track before pressing ctrl + B or cmd + B.)

e Type in using the standardized naming convention (this will eventually become the audio
file name). Each test should have a different Accession # with the corresponding test
noted in the data log.

14


https://youtu.be/72ewbraagj8

v 9.0 10.0 1.0 12.0 13.0 14.0

X | audio136154w audio1361544849
Mute = Solo | 1.0

- +

o 0.5 1

P Y M—W

Mono, 32000Hz
32-bit float 0.5 1

| [Test Name] [Subject ID] [Date]
@

¢ Find the space between the end of the first test and the beginning of the second test.
Click on the second label track at that location and use ctrl + B or cmd + B to create
another label. Name it appropriately. Do this at the beginning of every test.

Saving Processed Audio Files

After the PII and cognitive tests have been labeled and the PII is silenced, you need to save the
labels and audio files separately. To do so, follow these steps:

e To save the timestamps, click on File > Export > Export labels

6 audio1361544849
File Edit Select View Transport Tracks Generate Effect Analyze Tools Help
New Ctrl+N ’T_}- VAR
Open... Ctrl+0 4 o I:*-l C)\ * ol
Recent Files > -
Close Ctrl+W Q Q -9\ g Q’ [\) - °
phone Array (Realtek(R) Au ~ || 2 (Stereo) Recol

Save Project

Export > Export as MP3

Import > Export as WAV
Page Setup... Export as 0GG
Pri Export Audio... Ctrl+Shift+E
rint...
Export Selected Audio...
Bxit el Export Labels...
— _05 3
i Export Multiple... Ctrl+Shift+L
Al Select -1.0
Export MIDI —_
XJ Label Track w

e Save the timestamp file (.txt is the default file type) in the designated file location with the
standardized naming convention corresponding with the audio file. The text file will
contain timestamps for both PIl and the cognitive tests.

o Now it is time to save the audio files. Go to the label track that has labels for the

cognitive tests. On the far right side of the track, click on the black triangle next to “Label
Track” and select Move Track to Top:

15



File Edit Select View Transport Tracks Generate Effect Analy:
1 [ | 4 4! @ ) [
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v 0 15 30

| audiol36154w audio 1361544849
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g1 | 05
L R
e . " e 0.0
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B |
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Font...

e At the top of the program, click on File > Export > Export Multiple:

€ audio1361544849
File Edit Select View Transport Tracks Generate Effect Analyze Teols Help
{ "
New Ctrl+N , o a 1=/ i
Open... Ctrl+0 I L'

Recent Files » &i ﬂ
Close Ctrl+W 9\ e\ ,9\ g Q B L

Save Project phone Array (IRCBHER(R) Au || 2 (Stereo) Record
A T .0
Export > Export as MP3 .
Import > Export as WAV
Page Setup... Export as 0GG
Pri Export Audio... Ctrl+Shift+E
rint...
Export Selected Audio... *_
. B Export Labels...
- 057
e Export Multple.. CurleShifteL
a| Seect | [0
— - - Export MIDI... I

¢ The following menu will appear. Make sure you have these options selected:



Export files to:

Folder: [ Ch . Choose... Create
Format: | WAV (Microsoft) hd \
Make sure the | =¥ Select the folder
audio is saved you want to save
as WAV files. Options: Encoding: | Signed 16-bit PCM v the audio files in.

Split files based on: Name files: Files should be
O Tracks (®) Using Label/Track Name <= named using the
@® Labels (O Numbering before Label/Track Name
i Label names.
Files should [Jinclude audio before first label O Numbering after File name prefix
be split based 2uco1361544520 odio1361544810
on Labels

[ Overwrite existing files

Export Cancel 0

e Click Export. Several windows will pop up, click Ok for all of them. The program will
save the audio as individual files.

o Finally, save the Audacity project file in the designated file location. To do this, click on
File > Save Project > Save Project As... Use the Audacity project file to conduct QC
and make any necessary changes to the labels or audio.

All audio files should be stored in a secure location and backed up regularly.
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Quality Control (QC)

The exact process for ensuring data quality is subject to individual research protocol. We
recommend researchers integrating efforts with the existing QC procedures and documentation.
Below we offer suggested best practices that researchers may want to adopt if feasible.

Researchers should develop a system for tracking QC activities. This can be done using the
preferred program such as REDCap or Excel. It should, at minimum, track the following
variables:

Participant ID

Tester ID

Recording date

Name of audio file

ID of person conducting QC

Date of QC activity

What type of QC is being done (as outlined below: Supervisor, Peer, Intra, Data
Integrity, etc.)

Whether the QC passed or failed

Why the QC failed, if applicable

NogahswdbE

© x

We encourage researchers to create a feedback loop for the QC process. This means that the
people who conducted testing and processed the audio (this might be the same person or
different people) are sent the QC results so they can tell if they made any mistakes. The testers
and audio processers can sign off on the QC to confirm that they reviewed any errors.

Manual QC for PII

Given the importance of maintaining the confidentiality of research participants, it is essential
that QC measures are implemented to ensure consistent and accurate removal of PIl from the
recordings. While we provide a framework for QC below, we encourage researchers to adapt
and/or develop a process that works best with their existing infrastructure. Our recommended
format includes three levels of QC: supervisor, peer, and self (intra).

Supervisor QC: A supervisor should regularly choose recordings at random to undergo QC.
We recommend selecting at least one recording from each tester every month. They should
listen to the entire recording to check that all Pll has been labeled and silenced. If they find PII,
they should flag it and ask a staff member proficient with Audacity to label and silence the PII,
then save the audio file and timestamp (.txt file) as updated versions.

Peer QC: A Peer Reviewer should review 5-10% of the completed exams done by each tester
on a regular basis. The recordings should be chosen at random. This does not have to be a
trained NP tester; it just needs to be someone trained to listen for PIl. The Peer Reviewer
should listen to the recordings and make sure all Pl has been labeled and silenced. If they find
Pll, they should flag it and ask a staff member proficient with Audacity to label and silence the
Pll, then save the audio file and timestamp (.txt file) as updated versions.

Intra QC: Each person processing the audio should review their own test recordings, chosen at
random, to ensure all PIl was accurately identified (we recommend reviewing one recording a
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quarter). If they find PII, they should label and silence the PII, then save the audio file and
timestamp (.txt file) as updated versions.

Each recording that undergoes QC should be logged in the designated QC tracking system. On
a regular basis (we recommend quarterly), the tracking system entries should be reviewed to
ensure that there are not (1) common pitfalls or (2) problems with the accuracy of any particular
examiner or person processing the audio. Any common pitfalls or differences of opinion will be
discussed with the team and steps taken to resolve them. If the person processing the audio is
not consistently accurate, they should be given feedback and additional recordings from that
person should be reviewed. The number of additional recordings that will be reviewed will be
decided upon by a supervisor based on the given circumstances.

QC for File Labels and Locations

We strongly recommend that researchers implement a QC process that will ensure data files
are labeled correctly and located in the appropriate folders. This is essential because the
recording should contain no PII, which means the file name will be the only way to identify the
recording. Audio files must be labeled according to the prescribed naming convention that
corresponds with the correct row in the data log. Without a correct file name and match in the
data log, it will be extremely difficult to align the voice data with participant phenotypic data. The
file name and location should correspond with the data log with no discrepancies.
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Appendix A: Frequently Asked Questions (FAQS)

1.) How long should we expect audio recordings to be?

a. This depends entirely on the content that is being recorded. A set of
neuropsychological tests could take an hour, whereas other shorter cognitive
batteries may take less time.

2.) What sort of file sizes should we expect for audio data?

a. That depends on the format (e.g., uncompressed vs. compressed), duration of
the audio, sampling rate, bit-depth, and number of channels.

b. For example, a WAV (uncompressed format) audio file that is one hour long, has
16kHZ sampling rate, 16 bit-depth, and one (mono) channel is roughly 115.2 MB.

3.) How does a manual transcription process compare to an automated transcription
process?

a. Manual transcriptions take a significant amount of time to produce. It could take
about 7-8 times the length of the speech time to manually transcribe a recording.
It takes significant effort to define a robust set of guidelines that transcribers can
be oriented to — especially because the guidelines will likely adapt and change as
different scenarios are encountered.

b. Automated transcriptions are much faster to produce and are mostly limited by
available computational resources. However, the quality of the transcription
depends on the audio and the automated method being utilized.
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Appendix B: FHS-BAP Consent Form

CEN,

Boston Medical Center and the %ﬂ@i
Boston University Schools of Medicine, R [ BOSTON

Public Health and Dental Medicine EXCEPTIONAL CARE. WITHOUT EXCEPTION.

UNIVERSITY

RESEARCH CONSENT FORM

Basic Information

Title of Project: Precision Monitoring and Assessment in the Framingham Study: Cognitive, MR,
Genetic and Biomarker Precursors of AD & Dementia

IRB Number: H-40620

Sponsor: NIH/National Institute on Aging (NIA) Principal Investigator:

Lindsay A. Farrer, Ph.D. Chief, Biomedical Genetics

Professor of Medicine, Neurology, Ophthalmology, Epidemiology, and Biostatistics Framingham
Heart Study Investigator

72 East Concord Street, E200 Boston, Massachusetts 02118 farrer@bu.edu

P) 617-358-3550

F) 617-358-3551

Co-Investigators:

Rhoda Au, Ph.D., MBA

Professor of Anatomy & Neurobiology, Neurology & Epidemiology Senior Investigator &
Director, Neuropsychology

Framingham Heart Study 72 East Concord Street, B6

Boston, Massachusetts 02118

P) 617-638-4200

Jesse Mez, MD, MS

Associate Professor of Neurology

Associate Director, BU Alzheimer’s Disease Research Center Clinical Core Framingham Heart
Study Investigator

Boston University School of Medicine 72 East Concord Street, B-7800 Boston, MA 02118
jessemez@bu.edu

P) 617-358-6098

F) 617-358-6544

Study Phone Number: 617-358-6098
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Overview

We are asking you to be in a research study because you are a participant of the Framingham
Heart Study (FHS). A research study is an organized way of collecting information about
scientific questions. This form will tell you what you should expect if you agree to be in the
study. There are programs in place to make sure that investigators fulfill their obligations listed
in this form.

It is your decision whether or not to join the study. We are doing research designed to identify
the relationship between risk factors, genetics and brain function. If you agree, you will
participate in cognitive testing using neuropsychological tests, a neurological examination, and a
research brain MRI. As part of this study, you may be asked to have an informant complete a
guestionnaire about your functioning. If you have not previously elected a research proxy, you
will be asked to as part of this study. You will be in the study for approximately 5 years if you
decide to stay for the whole study. You will find more information about what will happen in this
study later in this form, including associated risks and benefits.

The main risks of being in this study are fatigue while completing the neuropsychological
testing, a small risk of falling during the neurological examination and discomfort while lying in
the MRI machine if you are claustrophobic. You will find more information about risks later in
this form.

Purpose
The purpose of the cognitive testing, neurological examination, and MRI portions of this study is

to obtain information on brain functioning (e.g., attention, language, visuospatial skills, memory,
motor function, etc.) and brain structure (visible on MRI scans). The results of these screenings
will be analyzed in conjunction with previously collected health and lifestyle (eg. exercise,
smoking) information in order to try to identify early indicators of cognitive health or disease in
aging. Additionally, in this study we will analyze research data about you that was previously
collected (e.g., cardiovascular and other disease diagnoses, blood biomarkers, exercise,
smoking, mood, bone density, etc) and that will be collected in the future as part of other FHS
research studies.

What Will Happen in This Research Study

The research will take place at the following location(s): The Framingham Heart Study Facility or
at your place of residence (either in person or remotely) and the Metro West Imaging Center in
Framingham, MA or another imaging center closer to you. The exam will take approximately 2.5
hours and is comprised of three primary components. You will be asked whether you agree to
each component after reading its description.

In Person Neuropsychological Examination (Cognitive Testing): This part of the exam will take
about 45 to 90 minutes and will take place in our office or in your home. You can take a break at
any time during the session. The neuropsychological examination is intended to measure
attention, language, visuospatial skills, executive functions, memory and other cognitive
functions.
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Remote Neuropsychological Examination (Remote Cognitive Testing): You will be offered the
option to continue participating remotely if you are unable to participate in-person. If this occurs
the following additional procedures will take place.

Before Your Virtual Visit: The virtual visit/remote testing will take place using your electronic
device. You will need to have steady access to the internet and will use your own device
(computer/laptop/iPad/tablet). There will be technical support for any questions prior to or during
the encounter. The remote testing will be done using a BU approved platform for interviews
such as Microsoft Teams and/or BU HIPAA Zoom.

During Your Virtual Visit: You will be asked similar questions and administered the same tests
that you would encounter during an in-person neuropsychological exam. The tests given
virtually will mimic in-person tests as much as possible with modifications only made to facilitate
virtual use. You may be offered a second in-person evaluation at your convenience, in your
home or at our office, in the future.

Do you agree to participate in the Neuropsychological Examination?
YES__NO ___N/A __INITIALS

Neurological Examination: This part of the exam will take approximately 20 to 30 minutes to
complete. You can take a break at any time during the session. The neurological examination
consists of a motor exam, which is an assessment of your coordination, reflexes, balance, and
walking. It also consists of a questionnaire that asks about your cognitive symptoms such as
memory, concentration, language, and mood and behavioral symptoms.

Do you agree to participate in the Neurological Examination?

YES__NO _N/A __INITIALS

MRI Screening: This part of the exam involves a brain MRI scan. You will be required to go to
MetroWest Wellness Center in Framingham, MA (or to any other analysis center authorized by
the Framingham Heart Study), where a photograph of your brain's physical structure may be
obtained. The MRI machine is standard diagnostic equipment consisting of a magnetic
superconductor located in a large open cylinder. As soon as you arrive, you will be asked to
complete a screening form. When you are ready to receive your MRI, you will be asked to take
off any metal objects (jewelry, glasses, retainers, etc.), change into cotton clothing that will be
provided to you, and select the music you would like to listen to through earpieces while you are
lying down in the machine. You will be provided with a locker to secure your belongings for the
duration of the scan. The MRI technician will help you to lie down in the machine, where you will
be asked to stay for 30 minutes.

Do you agree to participate in the MRI Scan?

YES_ _NO _N/A__INITIALS
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At the end of the visit we will ask you to fill out a brief survey about your experiences with the
study testing and the MRI scan.

Audio and Video Recording: The neuropsychological and neurological examinations will be
audio recorded. The motor assessment of the neurological examination and remote
neuropsychological exam will be video recorded. The audio and video recordings will be
analyzed in conjunction with other study information.

Do you agree to have the neuropsychological and neurological examinations audio recorded?
YES__NO ___N/A __INITIALS
Do you agree to have the neuropsychological and neurological examinations video recorded?

YES_ _NO __N/A __INITIALS

Call-back Examination: You may be contacted after your visit to ask if you would be willing to
consider additional neuropsychological testing and neurological examination. The duration of
the call-back examination is variable and may last as long as 2 hours. Additionally, if you
become cognitively impaired during this study, we may ask someone that knows you well to
participate in an annual questionnaire about your symptoms as an informant via phone call
(approximately 5-10 minutes).

Do you agree to be contacted for a call-back examination?
YES__NO ___N/A __INITIALS

The current duration of the study is anticipated to continue until 2025, and every 1-3 years you
may be asked to undergo repeat neuropsychological testing, neurological examination, and/or
MRI. You may be asked to come back for repeat testing and re- consented at each visit. You
reserve the right to refuse at any time.

Clinical, brain imaging, neuropathological data obtained previously or collected as a part of this
study, as well as demographic, medical and other clinical information, questionnaire responses,
biomarker, genetic and 'omic data derived from biological specimens previously or in the future
under other FHS protocols may be used for analyses. We will perform a whole examination of
your DNA or genome. Usually researchers study just a few areas of your genetic code that are
linked to a disease or condition. In whole genome studies, all or most of your genes are
examined and used by researchers to study links to a disease or condition.

24



Future Use and Sharing of Data:

The data that we collect as part of this study might be shared in the future with other
researchers who are studying cognition. These researchers could be from FHS/Boston
University, or they could be from outside of FHS/Boston University. The data might be shared
with non- commercial or commercial entities (unless you have previously indicated that you do
not permit your data to be shared with commercial entities). We cannot predict all of the future
research that might be done using the data we collect in this study. Additionally, there are
multiple studies taking place at FHS that use the same exams (heuropsychological exam,
neurological exam, and MRI). To reduce burden on you so that you do not have to repeat the
same exam for multiple studies, we will share the results of study exams with these other FHS
studies. Your identity will be shared when study data is shared with other FHS studies. To
obtain data, researchers from universities, hospitals, companies, health organizations, and other
entities may contact the central FHS data repository to request samples and data. FHS data
managers will review the way that these studies will be done and decide if any of the data can
be used. If you do not want your data used for other projects, you should not participate in this
study.

The ways we will protect your privacy and confidentiality are described in a separate section
later in this form.

You will be one of approximately 7,400 subjects who will be asked to be in the study.

Risks and Discomforts

Neuropsychological (NP) Examination: The primary risk and discomfort associated with the
neuropsychological examination is fatigue. Since these examinations take approximately an
hour to an hour and a half to complete, you may feel tired during the course of the testing. You
may ask for a rest at any time. Also, some individuals find testing to be frustrating. You may
choose to terminate the examination at any time and for any reason. The NP tests we are doing
in this study are for research purposes only. We will not tell you the results because it is not
known if they mean anything. However, if study staff has any significant concerns about your
cognitive functioning, a study doctor will call you, explain what was noticed, and recommend
that you see your physician. If necessary and with your permission, we will also call your doctor.
If you or your doctor decides that follow-up tests and treatments are necessary, then you or your
insurance will be responsible for the costs. There are no reports generated from the NP testing,
and therefore the results cannot be sent to you or your doctor.

Neurological Examination: There is a small risk of falling for participants who are unsteady on
their feet. You should notify the exam administrator of any problems in walking or movement
before the exam begins to minimize this risk. If a serious abnormality is detected during this
exam, a study doctor will call you, explain what was noticed, and recommend that you see your
physician. With your permission, we will also call and/or send the neurological exam findings to
your doctor. If you or your doctor decides that follow-up tests and treatments are necessary,
then you or your insurance will be responsible for the costs.

25



MRI: Due to the power of the magnet used in this procedure, certain metals are not allowed to
come in contact with your body, such as pacemakers and certain implants. All metal implants
and surgeries will need to be discussed and approved by a technician during a screening
procedure before the MRI scan can take place. As part of this procedure, you will be asked to lie
down on a platform, which will move you inside the cylinder from head to waist, and you will be
asked to be still. Other than the machine's loud noise, no risks or discomforts are expected
during this procedure. However, some people who are claustrophobic (afraid of confined
spaces) or bothered by loud noise may feel uncomfortable during this procedure. The MRI staff
is aware of these issues and take all necessary precautions to make any persons being
subjected to MRI feel safe and calm. You may choose to terminate this examination at any time
during the process.

The brain MRI in this study is for research purposes only. However, there is a very slight risk we
might see something that could be important to your health. If a serious abnormality is seen on
the research MR, a study doctor will call you to explain what we noticed and recommend that
you see your doctor. If you request that the MRI report be sent to you and/or your doctor, we will
ask you to sign a separate consent form that authorizes us to release that information. With your
permission, we will also call and/or send the MRI report to your doctor. You or your doctor
should not rely on the research measurements to make any diagnosis, treatment, or health
planning decisions. If you or your doctor decides that follow-up tests and treatments are
necessary, then you or your insurance will be responsible for the costs. The results of your
MRIs will not routinely be provided to you or your physician.

MRI scans are not known to be safe for pregnant women. Although there are also no known
risks to a pregnant woman, embryo, or fetus, you should not undergo an MRI scan unless you
are certain you are not pregnant.

There may be unknown risks/discomforts involved.

Potential Benefits

You will receive no direct benefit from being in this study. Your being in this study may help the
investigators learn about brain function and structure and risk for diseases affecting the brain.
Future generations may benefit from this research if we manage to better understand these
conditions. These studies may lead to developing methods for prevention and treatment of such
diseases.

Costs
There are no costs to you for being in this research study.

Payment

You will not be paid for being in this study. The research may lead to the development of drugs,
tests, or procedures that might have commercial value. You will not get any money if products
are developed from the research.
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Confidentiality

This study is collecting data including digital information from you. We would like to make your
data available for other research studies that may be done in the future. The research may be
about similar diseases or conditions (i.e. brain health-related conditions, cognitive status and
impairment)) to this study. However, research could also be about unrelated diseases,
conditions, or other types of research. These studies may be done by researchers at this
institution or other institutions, including commercial entities (if you previously consented). Our
goal is to maximize the amount of research conducted.

Your data may be shared with researchers around the world. However, the decision to share
your data and biospecimens is controlled by you. To obtain access to your data, future
researchers must seek approval following policies and procedures that meet NIH, local IRB
and/or other governing bodies, including those of FHS as well as those from other countries.
The researchers must agree not to try to identify you as part of the agreement to have access to
your data. We must use information that shows your identity to do this research. Information
already collected about you will remain in the study record even if you later withdraw.

We will store your information in ways we think are secure. We will store paper files in a locked
secure location. We will store electronic files in computer systems with password protection and
encryption. Access to these records is limited to authorized FHS staff. However, we cannot
guarantee complete confidentiality. The files will be kept indefinitely, and there are no plans to
destroy any of the records. Coded data and digital/video recordings from all tests will be stored
in a repository and will be shared with internal and external investigators. This means that your
data will be shared in a way where other investigators can gain access to them without review.
although your previously indicated preference of sharing data for commercial and/or non-
commercial purposes will be honored. Data may be shared with qualifying collaborators with or
without FHS investigator involvement. There are multiple studies taking place at FHS that use
the same exams (neuropsychological exam, neurological exam, and MRI). To reduce burden on
you so that you do not have to repeat the same exam for multiple studies, we will share the
results of study exams with these other FHS studies. Your identity will be shared when study
data is shared with other FHS studies.

We will protect your information by assigning a number/code to you and any identifying
information about you. Your coded information including raw data will be shared with non-FHS
investigators, but your name and other personal identifying information will not be shared, nor
will it be shared in reports, or publication. With the exception of the previously noted FHS-
approved studies, BU Medical Campus/BMC investigators as well as non-BU Medical
Campus/BMC investigators will receive coded data only and will not have access to the master
code list that links data to individually identifiable subject information. Coded data including
coded digital recording information, including audio and video, will be shared with, and analyzed
by qualifying collaborators inside and outside of BU Medical Campus/BMC that is not contingent
on FHS investigator involvement. In addition, the main purpose of this data collection is to gain
information on cognitive status and decline but once shared the data may be used for other
purposes. Your name and other personal identifying information will not be shared with these
entities.
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This study is covered by a Certificate of Confidentiality (CoC) from the National Institutes of
Health. All studies funded by the National Institutes of Health that involve identifiable information
are covered by a CoC. The CoC provides how we can share research information. Because we
have a CoC, we cannot give out research information that may identify you to anyone that is not
involved in the research except as we describe below. Even if someone tries to get your
information in connection with a legal proceeding, we cannot give it to them.

The CoC does not prevent you from sharing your own research information.

Genetic data that are collected from you through different FHS studies will be analyzed to find
out information about your genetics. Your genetics and health information, without your name or
other data that could easily identify you, will be put in a database run by the National Institutes
of Health (NIH). Summarized results of genetic analyses will be submitted to the National
Institute on Aging Genetics of Alzheimer’s Disease Data Storage Site (NIAGADS). These
results do not represent individual-level genetic information. This may include your whole
genome information. Other researchers can ask the NIH to get your information from the
database. You should know that it is possible that your genetics information might be used to
identify you or your family, though we believe it is not too likely that this will happen. Once your
information is given to the NIH database, you can ask to have NIH stop sharing it, but NIH can’t
take back information that was already shared.

If you agree to be in the study and sign this form, we will share information that may show your
identity with the following groups of people:
e People who do the research or help oversee the research, including safety
monitoring.
o People from Federal and state agencies who audit or review the research, as
required by law. Such agencies may include the U.S. Department of Health and
Human Services, the Food and Drug Administration, the National Institutes of Health,
and the Massachusetts Department of Public Health.
e People from entities that provide a service for the study (i.e. MRI scans, PET scans,
digital
audio and video recording processing/ transcription, etc.), or other FHS approved investigators.
These people are expected to protect your information in the same way we protect it.
e Any people for whom you give us separate permission to share your information.

You should know that we are required to report information about a child, elderly person, or
disabled person who is being hurt or is at risk of being hurt, and if we become concerned about
your safety and aware that you intend to harm yourself or someone else.

We will share research data where we have removed anything that we think would show your
identity. There still may be a small chance that someone could figure out that the information is
about you. Such sharing includes:

e Publishing results in a medical book or journal.
e Adding results to a Federal government database.

e Using research data in future studies, done by us or by other scientists. You will be
kept informed of new information and findings via periodic publications by the
Framingham Heart Study.
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Subject’s Rights

By consenting to be in this study you do not waive any of your legal rights. Consenting means
that you have been given information about this study and that you agree to participate in the
study. You will be given a copy of this form to keep.

If you do not agree to be in this study or if at any time you withdraw from this study you will not
suffer any penalty or lose any benefits to which you are entitled. Your participation is completely
up to you. Your decision will not affect your ability to get health care or payment for your health
care. It will not affect your enrollment in any health plan or benefits you can get.

Questions

The investigator or a member of the research team will try to answer all of your questions. If you
have questions or concerns at any time, contact either study co-Investigator: Dr. Rhoda Au at
617-638-4200 or Dr. Jesse Mez at 617-358-6098. Also call if you need to report an injury while
being in this research.

You may also call 617-358-5372 or email medirb@bu.edu. You will be talking to someone at the
Boston Medical Center and Boston University Medical Campus IRB. The IRB is a group that
helps monitor research. You should call or email the IRB if you want to find out about your rights
as a research subject. You should also call or email if you want to talk to someone who is not
part of the study about your questions, concerns, or problems.

By agreeing to be in this research, you are indicating that you have read this form (or it has
been read to you), that your questions have been answered to your satisfaction, and that you
voluntarily agree to participate in this research study.
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Subject:

Printed name of subject

By signing this consent form, you are indicating that
e you have read this form (or it has been read to you)
e your questions have been answered to your satisfaction
e you voluntarily agree to participate in this research study
e you permit the use and sharing of information that may identify you as described

To be completed by subject if personally signing

Signature of subject Date

To be completed by LAR if subject does not personally sign
| am providing consent on behalf of the subject.

Printed name of Legally Authorized Representative (LAR) Relationship to Subject
Signature of Legally Authorized Representative Date
Researcher:

Printed name of person conducting consent discussion

To be completed by researcher if subject personally signs
I have personally explained the research to the above-named subject and answered all

guestions. | believe that the subject understands what is involved in the study and freely agrees

to participate.

Signature of person conducting consent discussion Date
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To be completed by researcher if subject does not personally sign

| have personally explained the research to the above-named subject’s Legally Authorized
Representative and answered all questions. | believe that the Legally Authorized Representative
understands what is involved in the study and freely agrees to have the subject participate. |
consider that the above-named subject (check one):

O is capable of understanding what is involved in the study and freely agrees to patrticipate.

O is not capable of understanding what is involved in the study.

Signature of person conducting consent discussion Date

To be completed by witness if researcher reads this form to the subject/LAR
This consent form was read to and apparently understood by the subject/Legally Authorized
Representative in my presence.

Printed name of witness (a person not otherwise associated with the study)

Signature of witness Date
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Appendix C: Recording with the ZOOM H4N DVR

Initial Set-up

1. Turn the power on by moving the power switch on the left panel of the device to
“ON’!.

2. Press the menu button on right side of recorder.
3. Scroll to “SYSTEM” and enter it.

4. Enter “DATE/TIME” and set the date and time. The recorder uses military time.
Press “OK”.

5. Return to the menu and enter “REC”.

6. Change “REC FORMAT” to “WAV48kHz/24bit”. Exit out of the menu completely by
repeatedly pressing the menu button.

7. Change the recording level to 50 using the “REC LEVEL” rocker on the right side of
the recorder.

8. Set microphones to 120°.

9. Initial set-up is complete. You may turn off the device.

Loading the SD Card

1. Be sure the power is OFF when inserting or removing the SD card to avoid
destroying data.

2. Insert the SD card into the slot on the left panel of the device

a. If “Format Card” appears on the display screen after inserting the card, it
means that the SD card has not been formatted in the H4n Pro device. To format
it, use the dial to select “YES”.

3. To check the remaining capacity of the SD card, press “MENU” and select “SD

CARD”. Select “REMAIN” which will then display the remaining capacity meter,
remaining space, and remaining recording time using the current settings.

Recording Instructions

1. The recorder should always have functioning batteries installed, regardless of
whether an AC adapter is being used.
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2. Plug recorder into the AC adapter in the testing room (or, if testing elsewhere, have
an AC adapter with you and try to arrange the testing location so you can plug in the
recorder).

3. Turn the power on by moving the power switch on the left panel of the device to
“ON”

4. Be sure the “Stereo Mode” indicator is lit.

5. Put the recorder in “Recording Standby Mode” by pressing the “REC” button.
a. Recording standby means the mic is on but is not yet recording.
b. The red light on the recorder blinks when in standby mode.

6. Confirm all settings are correct (recording level = 50; recording format =
WAVA48kHz/24bit; microphones are at 120°). See Initial Set-up section above for
instructions.

7. Make sure that the MIC button is pushed on the front of the recorder (NOT the “1” or
“2” buttons); see the ZOOM H4N DVR Image below.

8. Start recording by pressing the Play/Pause [»/||] button. The time counter on the
screen will advance, the recording symbol [e] will appear next to it, and the red light will
stop blinking and remain on.

9. Record the following information: Participant ID, Date of testing, and Examiner ID.

10. Press the Play/Pause [»/||] button again to pause recording until ready to start
recording the participant.

11. Lay the recorder down with the head of the recorder pointed directly at where the
participant will be seated. In testing rooms, place the recorder on the file cabinet next to
the testing table, as close to the participant as possible. It's absolutely essential to place
your paper holder on the opposite side of the table relative to the recorder, because the
recorder is very sensitive and paper shuffling will muddle audio. If you are notin a
testing room, try to arrange to place the recorder on a different surface, but still close to
the participant, so it does not pick up all the paper shuffling, table jarring, etc.

12. After the participant has been consented and has signed the consent form, you may
begin recording the examination. For our NP studies at FHS, however, we have IRB
approval to audio record the consent process itself. In this case, first tell the participant,
“We will be audio recording this session for analysis and quality control purposes” (or
something along those lines), then begin recording. NOTE: If the participant reports that
they do not want to be audio recorded, turn off the recorder, remove it from the table,
and proceed with consenting/testing (unrecorded).

33


https://indiana-my.sharepoint.com/personal/hacraft_iu_edu/Documents/Documents/IADRC%20P30/CTF%20Cognitive%20Working%20Group/Digital%20Voice%20Capture%20Manual/Digital%20Voice%20Capture%20Manual%20Shared%20Folder/Framingham%20Digital%20Voice%20Capture%206_28_21.docx#_ZOOM_H4N_DVR
https://indiana-my.sharepoint.com/personal/hacraft_iu_edu/Documents/Documents/IADRC%20P30/CTF%20Cognitive%20Working%20Group/Digital%20Voice%20Capture%20Manual/Digital%20Voice%20Capture%20Manual%20Shared%20Folder/Framingham%20Digital%20Voice%20Capture%206_28_21.docx#_ZOOM_H4N_DVR

13. Since you are currently in “Standby” mode, press the Play [»/||] button. Again, the
time counter on the screen will advance, the recording symbol [e] will appear next to it,
and the red light will stop blinking and remain on. MAKE SURE THIS IS ALL
HAPPENING BEFORE PROCEEDING WITH TESTING.

14. Optionally, you may now slide the power switch toward “HOLD” on the left panel of
the device to disable button operation during recording (although preferably you will not
be touching the recorder at any time during testing, so this should not be necessary).

15. After all testing is complete, stop the recording by pressing the stop button [m].

16. YOU MUST TURN OFF THE RECORDER BEFORE UNPLUGGING THE A/C
ADAPTER OR ELSE THE RECORDING MAY BE LOST. (This is only true if the
batteries in your recorder are dead, but you should always follow this procedure to
ensure data is not lost.

Although you are unlikely to need to play the recording back on the DVR device itself,
because you will be using the ELAN software, this can be done by pressing the, [»/||]
button to play and the, [=] button to stop.

To play an older recording back, press “MENU” then select “FILE” using the dial. Select
the file to play and press. Select “SELECT” and press. Press the [»/||] button to start
playback.

Using USB to Transfer Files

1. Connect device to computer with USB cable.

2. Press the “MENU” button on the right panel of the device.

3. Select “USB” using the dial and press.

4. Select “STORAGE” and press.

5. The device is now connected to the computer and the files can be transferred

6. Save the file in the appropriate file location with the file naming convention for
unedited recordings

Dividing or Deleting a File

It is unlikely you will need to use these features; however, in the rare case that it may be
necessary (e.g., two participants were accidently recording in the same file), follow
these directions:

1. Press the “MENU” button on the right panel of the device.

2. Select “FOLDER” using the dial and press.
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Select a folder using the dial and press.

a. To divide a file and a desired position, select “DIVIDE” and press. Press to
start the playback and press again at the division point. Select “YES” to confirm
the divide.

b. To delete a file, select “DELETE” using the dial and press. Select “YES” to
confirm deleting. **Never delete files from the recorders until you are 100%
certain they are correctly stored on the N drive**

Battery Type

1.
2.
3.
4.

To display the remaining battery life when using batteries, press “MENU”
Select “SYSTEM” using the dial and press.
Select “BATTERY” using the dial and press.

Select the battery type: Alkaline or Ni-MH.

Software Update

1.

To download the most recent system software, the device with an SD card must be

connected to a computer with access to the internet.

2.
3
4.
5.

6

Open the ZOOM website (http://www.zoom.co.|p)

Connect the H4n Pro to the computer with the USB cable
Copy the downloaded software to the root directory of the SD card
Disconnect the H4n Pro

Turn it on while holding down the [»/||] button. Select “OK” when prompted to

upgrade the version.
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Check to be sure
that for Input the
“MIC” button 1s

pressed!!

If either the “1” or “2” button is
pressed, the recorder thinks there is
an external mic, and it will not
record anything.

A visual check to be sure that the
recorder is actively recording:
1. MIC and REC buttons are both

on and solid (NOT blinking)
2. The time counter is running
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Appendix D. Digital Voice Recorder Alternatives

This list was compiled by FHS-BAP and was last updated in June 2020. It can serve as a
resource for researchers that are “shopping around” to find a recording device that best suits
them. Please note that some details may become outdated over time as device specifications
and models change.

Sony ICD-PX370 Mono Digital Voice Recorder with Built-In USB Voice Recorder
® Record in MP3 audio quickly and easily.

® MP3 files are compressed but require less memory, making them better for recording
long lectures or meetings.

® Record up to 57 hrs of audio (MP3 128 kbps) with exceptional battery life that makes it
possible to record for long periods of time.

® Transferring files to or from your computer is fast and convenient. Just plug the ICD-
PX370 straight into a free USB port for an immediate connection—no USB cable
needed.

® Turn on Auto Voice Recording and the ICD-PX370 will optimize audio capture settings
for vocal frequencies. The result is a purer recording with reduced background noise.
And when you listen back to the recording, Clear Voice technology cleans up the signal
even more for improved clarity.

® The 4GB2 memory stores up to 59hrs35m of recording (MP3 128kbps stereo).

® Choose from four 'scene’ presets (music, meeting, interview, dictation) to optimize the
audio settings.

32GB Digital Voice Recorder, Homder Voice Activated Recorder

® Dynamic noise reduction chip & dual microphones to capture sound clearly, gives you a
really clear and natural audio.

® All recordings are named with a timestamp, convenient to find the file you are looking
for.

@ Built-in 32gb flash memory stores up to 2,000+ hours of maximum recording time

® utilizes DSP digital & AGC noise reduction technology to enhance human speech
recordings and filter out background noise, to give a really full clear and warmer vocal
recording.

® A single full charge (about 4 hrs) could be continuously used 60+ hrs.

® Multiple high-fidelity speakers ensure a crispy & loud enough playback even without
headphones.

® Password function keeps your files far away from leaking.
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EVISTR 16GB Digital Voice Recorder Voice Activated Recorder with Playback

Voice Activated Record

Reduce blank and whispering snippet

Voice Recorder USB Rechargeable

File name with Year, Month, Day, Hour, Seconds

Dynamic noise cancellation microphone, capture 1536kpbs crystal clear audio

Voice Recorder MAC Compatible (WIN Compatible)

Easy to figure out, press REC: starts to record; press STOP, save the recordings safely.
Small Voice Recorders with A-B repeat, fast forward, rewind function during playback, a
helpful recorder for lectures, meetings, interviews, speeches, class

Voice Activated Recorder: set the AVR voice activated function, record only when the
teacher is speaking, reduce blank and whispering snippets, save space and time.

Recording your appointment, meetings, interviews,speeches, lectures easily.

Easy File Management: recordings with time stamp, easy to find out when you recorded,
what it recorded.

#1 best-seller on amazon
Does not have Autosave feature

O Do not shut down the device until you press STOP to confirm the file saved
properly, it will show “Saved!”

O Do not shut down the device, while you are formatting, wait until it shows “format
completed”

16GB Digital Voice Activated Recorder - aiworth 1160 Hours Sound Audio Recorder Dictaphone

E36 voice recorder equipped with dual sensitive microphone and professional recording
IC, support up to 1536Kbps PCM recording,provide a super clear recorded voice

Built-in 800mAh rechargeable battery, support up to 45 hours continuous
recording.16Gb flash memory could save 1160 hours recording files at most,

in addition to this can support up to 32GB TF card(In addition to purchase) expansion
and voice activated recording.

The most user friendly voice recorder designed by aiworth, all operation buttons on the
front side, operational logic like smart phone.

With graphic user guide

Lifetime software update
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Power-on password protection- 3-digit password,8000 combinations; without the
password, no one could turn on the device and overheard your recorded files.After three
trial and errors, device will auto turn off.

16 levels to adjust the play speed; play faster, jump to the point you exactly want to
playback;play slowly let you hear every single word clearly.

Aomago 8GB Audio Recorder Mini Portable Tape Dictaphone with Playback, USB, MP3

This recorder upgraded its higher sensitive microphones, meaning that you can enjoy
premium quality sound.

Simple three-click recording, saving and playing, make it super user friendly.

Set the recorder to voice activated recording, catch the speaking words only.

A-B REPEAT FUNCTION: This is a great feature to help you study language, review
lessons from selected starting point A to ending point B. You don’t have to go back or
forward to listen to the words any more.

Easy transfer files: Voice recorder mac compatible. It supports recording files in MP3 or
WAV format. You can transfer files easily by connecting to a computer via supplied
Micro USB cable.

8GB MEMORY CAPACITY

High Quality (128 kbps) : 7680 Mins

Short Play (64 kbps) : 16920 Mins

Long Play (32 kbps) : 33120 Mins

7 EQ modes

Different languages

USB connection, for uploads and downloads

Battery life expectancy: up to 12 hours continuous recording

Warning:

Do not use the right “POWER” button to totally shut down your voice recorder, or it will
reset your voice recorder system time to default.

We suggest you press the PLAY/PAUSE button for two seconds to power off your voice
recorder, and next time you just need to press “PLAY/PAUSE” again to wake up your
voice recorder.

When Battery is almost exhausted or too weak, functions may be limited, please
recharge!
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Charge time between 3 to 4 hours, turn on the voice recorder before charging.

Press the REC button while recording to pause or resume recording. The LED will flash
when the recording is paused.

Wohlman. Digital Voice Recorder 16GB 1536kbps Touch Screen High Recording Quality Noise
Reduction Easy Operation Auto Activation MP3 Voice Recorder

Clear recording with a resolution of 1536 Kbps and microphones with dynamic noise
reduction, higher bit rate, higher recording quality, crystal-clear recordings and MP3
player.

The built-in 180mAh battery can record 12 hours continuously. With 16 GB of internal
storage, you can save up to 145 hours of recordings or 1500 songs.

Automatic recording is possible with the preset time. Simply record and save with the
"REC / Save" button. Simple operations with touch buttons.

With the automatic voice recognition function, the recorder automatically starts recording
when the sound is recognized. Without sound, it will be in standby mode to reduce
recording capacity and power consumption. The detecting distance can reach up to
10m.

With the A-B repeat play function, the recording can play back within a certain period of
time. You can also fast forward and rewind during playback, which is useful for reviewing
lessons, meeting records, songs, interviews, etc. We offer a one year guarantee.

With the USB cable, you can easily transfer the files to the computer as well as delete
the files directly. Compatible with Windows and IOS systems.

The password setting secures your recording data

Tschisen V93 is embedded with AGC noise reduction design and will give you high
quality recordings.

Speech recognition automatically picks up detected sounds and stops recording when it
is quiet.

Olympus Voice Recorder WS-853 with 8GB, Voice Balancer, True Stereo Mic

High quality MP3 recording

USB Direct connect with battery charge function

8 gb internal memory

Micro SD card slot

Playback speed control 0.5X to 2.0X

The True Stereo Mic with two directional microphones positioned at a 90 degree layout,

enables highest quality recording with an authentic stereo experience.

40



By differentiating the position and the distance of the speakers in meetings and
conferences the recording is highly precise, letting you feel as if you are actually in the
recording scene.

Auto Mode function makes it easier for users by automatically adjusting the microphone
sensitivity according to the volume of the speaker. To set this function, simply select
'Auto’ for the recording level from the menu.

The Simple Mode supports beginners by having the recorder display only the necessary
information in large font. It also limits the functions in the menu to those which are
frequently used.

For advanced users, the Normal Mode with full functionality is recommended.

The WS-853 can connect directly to a computer via the built-in USB connector. This
makes it possible to easily save data anytime, anywhere without the need to bring along
a USB cable. Furthermore, WS-853 is equipped with a protective cover to keep dust out
of the connectors.

The built in stand placed on the back of the body is carefully designed to reduce the
noise from the surface when the recorder is placed on a table. It works much like a
kickstand and allows users to read the menu without having to look down at the
recorder.

When recordings contain multiple speakers, the Voice Balancer makes smaller voices
louder and ensures that louder voices stay below a given level, providing playback
where everyone can be heard clearly. This comes in handy when recording sound
sources from multiple positions, such as at a meeting. The prominent noise produced
when amplifying small sounds is reduced. By eliminating the lower and higher frequency,
the voice is even more enhanced.

The noise-cancellation function powerfully reduces unwanted ambient noise such as air-
conditioner noise or projector fan noise enabling clear playback quality. The function is
very effective when playing back meeting recordings.

NYTIMES #2 pick

Sony ICDUX560BLK Digital Voice Recorder 1" Black

NYtime #1 pick for voice recorders

Built in stereo microphone and voice operated recording

Three recording options: wide/stereo, narrow/focus and normal

Quick charge; up to 1 hour recording time, with 3 minute charge

Easy to use user interface and recording level indicator

Micro SD memory card slot, headphone jack & mic input. LCD backlight

Record in MP3/LPCM with a high-sensitivity S-Microphone
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Up to 4 GB of built-in storage, expandable via MicroSD (SDHC/SDXC) cards
Focus and wide microphone modes to suit lectures or meetings

Direct USB built-in for easy connection to PC

FM radio to listen to or record radio broadcasts

Normal, focus, and wide-stereo recording provide you with the opportunity to record the
audio that you need to capture in any environment, while the slim and lightweight build
make it easy to take with you wherever you go and the easy to use up makes file
searching simple.

UX560 received the highest overall ratings from our panel of test listeners (nytimes). It
produces clear, understandable audio in the classroom, quiet office, and noisy coffee
shop settings. It also offers a better collection of features than the other models we
tested, with an easy-to-navigate menu system, a bright backlit screen, 39 hours of
recording time (in MP3 format), 27-hour battery life, voice-activated recording to pause
and restart after silences, and a pop-out USB 3.0 connector that lets you recharge the
recorder and transfer files to a computer easily. Like many of the other recorders we
looked at, it comes with an adequate amount of onboard storage (4 GB) but accepts
microSD cards, so you can record and store hundreds of hours of recorded audio should
you need it. The UX560 is also the slimmest recorder we tested—at 0.43 inch thick it can
easily fit in a shirt or pants pocket.

SONY PCM-D10

Reliable hi-res recordings of up to 192kHz/24-bit

3-way adjustable high-resolution 40K frequency response microphones
2 XLR-TRS combo jacks with 48V phantom power

Digital dual-path limiter function prevents distortion

Bluetooth capability for both remote control and playback via Sony's free REC Remote
app

More expensive than most ($500)
Commonly used for podcasters, radio, amatuer film makers

Capture flawless Hi-Res sound anytime, anywhere with the pcm-d10 portable recorder.
Record professional sound with Hi-Res Audio at up to 192kHz/24-bit. Whether it's your
live music set, new podcast episode or breaking news report, the pcm-d10 unlocks a
new level of detail and texture. The three-way adjustable microphones adapt to your
situation, while the twin XLR/TRS combo jack lets you plug in your choice of input. High-
guality dual ADCs maximize S/N and independent analog volume dials give you precise
control of your inputs.

Tascam DR-05 recorders
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The dual internal condenser microphones can handle anything from subtle to loud, with
sensitivity to capture every detalil

A revamped layout means operations like recording, adjusting levels, deleting bad takes
and adding Markers are quick and easy

Uses only two AA batteries, but can record for an outstanding 17. 5 hours; It can also be
powered by a USB mobile battery

Connect to a PC using USB Audio Interface Mode for voiceover work, live streaming,
podcasting and songwriting with studio-quality audio

Used in a study investigating pitch modulation in human mate choice

O In this study the researchers used a sampling rate of 96 kHz and 24-bit amplitude
guantization. Recordings were stored onto microSDHC media cards as
uncompressed WAV files and later transferred to a laptop computer for editing
and analysis. This method allowed us to obtain high-quality, directional voice
recordings that would otherwise be difficult to obtain in a noisy environment using
a stationary microphone.

O Acoustic editing and analysis were performed in Praat v. 6.0.21 [32]. Fragments
of silence, acute noise, non-verbal vocalizations (e.g. laughter) and multi-voicing
(e.g. the voice of the dating partner) were first manually removed from audio files.
Recordings were then segmented into multiple parts each corresponding to a
given participant and a single speed date. We further split each sound file into
three equal time segments (beginning, middle and end of the date; mean
segment duration 50.6 + 23 s), resulting in a total of 726 voice clips for acoustic
analysis.
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Appendix E: Digital Voice Publications

1. Lin H, Karjadi C, Ang TFA, Prajakta J, McManus C, Alhanai TW, Glass J, Au R.
Identification of digital voice biomarkers for cognitive health. Explor Med. 2020;1:406-
417. doi: 10.37349/emed.2020.00028. Epub 2020 Dec 31. PMID: 33665648; PMCID:
PMC7929495.

Identification of digital voice biomarkers for cognitive health - PMC (nih.gov)

2. Thomas JA, Burkhardt HA, Chaudhry S, Ngo AD, Sharma S, Zhang L, Au R, Hosseini
Ghomi R. Assessing the Utility of Language and Voice Biomarkers to Predict Cognitive
Impairment in the Framingham Heart Study Cognitive Aging Cohort Data. J Alzheimers
Dis. 2020;76(3):905-922. doi: 10.3233/JAD-190783. PMID: 32568190.

Assessing the Utility of Language and Voice Biomarkers to Predict Cognitive Impairment
in the Framingham Heart Study Cognitive Aging Cohort Data - IOS Press

3. Xue C, Karjadi C, Paschalidis IC, Au R, Kolachalama VB. Detection of dementia on
voice recordings using deep learning: a Framingham Heart Study. Alzheimers Res Ther.
2021 Aug 31;13(1):146. doi: 10.1186/s13195-021-00888-3. PMID: 34465384; PMCID:
PMC8409004.

Detection of dementia on voice recordings using deep learning: a Framingham Heart
Study - PMC (nih.gov)

4. Zhang L, Ngo A, Thomas JA, Burkhardt HA, Parsey CM, Au R, Ghomi RH.
Neuropsychological test validation of speech markers of cognitive impairment in the
Framingham Cognitive Aging Cohort. Explor Med. 2021;2:232-252. doi:
10.37349/emed.2021.00044. Epub 2021 Jun 30. PMID: 34746927; PMCID:
PMC8570561.

Neuropsychological test validation of speech markers of cognitive impairment in the
Framingham Cognitive Aging Cohort - PMC (nih.gov)

5. Amini S, Hao B, Zhang L, Song M, Gupta A, Karjadi C, Kolachalama VB, Au R,
Paschalidis IC. Automated detection of mild cognitive impairment and dementia from
voice recordings: A natural language processing approach. Alzheimers Dement. 2022
Jul 7:10.1002/alz.12721. doi: 10.1002/alz.12721. Epub ahead of print. PMID: 35796399;
PMCID: PMC10148688.

Automated detection of mild cognitive impairment and dementia from voice recordings: A
natural language processing approach - Amini - 2023 - Alzheimer's &amp; Dementia -
Wiley Online Library

6. Ding H, Mandapati A, Karjadi C, Ang TFA, Lu S, Miao X, Glass J, Au R, Lin H.
Association Between Acoustic Features and Neuropsychological Test Performance in
the Framingham Heart Study: Observational Study. J Med Internet Res. 2022 Dec
22;24(12):e42886. doi: 10.2196/42886. PMID: 36548029; PMCID: PMC9816957.
Association Between Acoustic Features and Neuropsychological Test Performance in
the Framingham Heart Study: Observational Study - PMC (nih.gov)

7. Tavabi N, Stick D, Signorini A, Karjadi C, Al Hanai T, Sandoval M, Lemke C, Glass J,
Hardy S, Lavallee M, Wasserman B, Ang TFA, Nowak CM, Kainkaryam R, Foschini L,
Au R. Cognitive Digital Biomarkers from Automated Transcription of Spoken Language.
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